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FOREWORD 
WELCOME TO THE WEBACAPPELLA USER’S GUIDE . 

 

Thank you for choosing WebAcappella. 

 

Welcome to the WebAcappella user’s guide... 

 

For more information or help, you can check the WebAcappella  Website. 

 

Wishing you a pleasant website creation! 
  

 

http://www.webacappella.com/help.html
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QUICK START GUIDE : 
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GETTING STARTED 

YOUR FIRST WEBACAPPELLA WEBSITE IN 5 EASY STEPS! 

 

When you run your software for the first time, WebAcappella asks you to create a new 

Web project and to give it a name. 

  

This will allow you to identify your site,  

to store it and to locate it each time you 

open the software. 

  

A quick start up guide is also available  

to you. 

 

  

 

 

 

 

 

Once you have named the project, you can choose a sample website template from 

those available (categorized by theme) or you can choose to create your own website 

from scratch by clicking on “Empty website” at the bottom of the templates list. 

 

Next, replace the images and text 

elements with your own content. 

 

 

Now you are ready to create the first page 

of your website! 

 

 

 

 

 

 

CREATING WEB PAGES 

 
When you click on “Empty website", you access the “Creating web pages” section. 

 

Begin by choosing the properties of the page. 

Using the “Pages/templates” menu, select “Page properties”. 

  

Click on the “Background” tab of the window that opens up:    
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- Size of workspace: you can modify the height and width of the dimensions of your 

workspace, where the elements of the page will be placed (standard size by default). 

These dimensions match the dimensions of the website’s pages. 

- Color or background image: select a color or a background image for your page. 

 

 

 
 

 

WebAcappella allows you to choose the elements you want to add and to decide where 

to place them. 

  

Use the “Insert” menu to add elements to your page  

(images, text areas, buttons, menus, etc). 

 

All elements are fully customizable in terms of their properties (size, borders, links, etc). 

  

Add new pages that you can rename as you like. 

Then, you can very easily link the pages using the navigation buttons and menus on your 

site. 

  

Some functions can only be accessed on the paying versions of WebAcappella.  

More information 

 

 

CREATING TEMPLATES 

 
When you start designing your website, we strongly recommend using the templates  

in order to apply a uniform page layout and design to all the pages of your site.  

Each template is therefore made up of the same elements: banner, browsing menu(s), 

background color, logo, etc. The content (text, photos) should be placed in the different 

pages. 

  

To make changes, you simply need to modify the template. 

The changes will be applied to all pages using the same template. 

http://www.webacappella.com/buy_product.html
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To create a template, click on the “Templates Explorer”     icon on the left of the 

screen. A new empty page is added to the Templates Explorer. 

 

 

Design your template following the instructions in Creating web pages. Your template 

can consist of images, color zones, menus, buttons, etc. 

 

 

Once your template has been created, it can be applied to all pages. 

 

 To do this, go to the “Page Explorer”. Display the page 

properties of the page being created. In the 

“Background” tab, tick the “Use a template as a 

background” box.  

 

Then, select your template and click on “OK”. 

  

  

Note : Elements included on a template cannot be modified directly on the pages. 

 

 

PREVIEWING & PREPARING BEFORE PUBLISHING YOUR WEBSITE 

Previewing your site 

 

The format of your website as it appears on WebAcappella will look exactly the same 

once it has been published online. 

 

 View the result of your work by displaying it on your Internet browser. 

Click on the “Preview" button of the toolbar and your favourite Internet 

browser will open and display the page. 

 

Preparing before publishing: SEO 

 

A good SEO (Search Engine Optimization) means that your website will have more 

visibility on Internet. This includes search engine results. 

  

The SEO of your site must be done through the properties of your website and the page 

properties. Fill in the fields of SEO window for every page of your website.  

Select the “Pages / Templates” menu, “Page properties”. 

  

Fill in the following information: 



WebAcappella 4 user’s guide – July 2014 

 

Copyright Intuisphere® - All rights Reserved  11 

- Page name: This is the text that appears in your website address. You can therefore 

replace the default name “wa_xx.html” by the name of your choice. (For example: the 

internet address of the contact page is http://www.webacappella.com/contact.html). 

Do not insert any spaces or special characters. 

- Page title: this refers to the text that appears at the top of the web browser interface. 

- Meta keywords: these words summarize the content of your page and are used by 

search engines to get to your website. 

- Meta web page description: this refers to the text that appears in search engines to 

describe a web page. 

 

PAGE DESCRIPTION EXAMPLE 

 

PUBLISHING AND SAVING 

Configuring publication 

 

Go to the “File” menu, “Publishing parameters”.  

 

1 - Fill in the required fields in order to publish your website on Internet (such as the 

server, user name, password, and the remote FTP file… this information has been 

provided to you by your host). 

  

2 - Test the connection in order to check your parameters (if you have followed previous 

step, you should not encounter any problems). A 24-hour period is generally needed to 

activate your website depending on the hosting supplier. 

 

Publishing 

 

Now all you have to do is publish your website (send it to the host). 

Click on the “Publish” icon in the toolbar. If you have correctly filled in the information 

(publishing parameters), the site will be published automatically. The website transfer 

time can vary depending on the size of your site and your Internet connection. 

 

A window informs you of the publishing progress. 

  

At the end of the operation, WebAcappella informs you of the result of the transfer, the 

size of your site, as well as the address on which your site can be consulted. 
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If you make any changes to your site, only the modified files will be transferred allowing 

you save time when it comes to publishing changes. 

 

  

 

 

 

 

 

 

 

Saving a copy of your website 

 

We recommend that you regularly save a copy of your website so your work is not lost, 

in case of problems with your computer. 

 

  

- In the menu bar, click on “File”, then “Backup project in an archive”. 

 

- Choose a location for the saved file (other than your hard drive: USB key, rewritable 

disk, etc, so that you can retrieve your files in case your hard drive crashes). 

 

- Click on “Confirm”. WebAcappella will save a copy of your work (as a ZIP file) in the 

location of your choice. 
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SOFTWARE 

INTRODUCTION 
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INTRODUCTION 
GENERAL PRINCIPLES OF THE SOFTWARE 

 

CREATING A PROJECT 

First, you must create a project and give it a name. This should allow you to easily find 

your work when WebAcappella is launched.  

 

Simply click on the "Create a web project" button. Give a name to your project (without 

spaces) and click on OK. 

 
 You can delete a project by clicking 

on the trash button situated under 

the project list. 

 

 

Caution: If you delete a project 

the Websites included in it will be 

deleted too. 

 

 

Keywords: opening 

WebAcappella, starting with 

WebAcappella, create a site, 

create a web project, beginning, 

begin, new, first, start  

 

 

 

 

 

 

CONFIGURING YOUR WEBSITE PUBLICATION 

The configuration parameters will allow you to place your WebAcappella site online by 

filling in the publication information provided by your Web hosting service.  

 

To access the configuration interface, click on the "Publication parameters" button. 

 

You can access at any moment this configuration window from the menu "Files" - 

"Publication parameters". 
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You will find 3 configuration tabs: 

- General 

- Database management 

- Mail 

General configuration tab 

 

Fill in the fields ("Host", "Login", "Password", "Remote FTP folder") with the 

information provided by your Web hosting service 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Protocol: By default, the protocol is set to the most common protocol that is FTP. If your 

hosting service uses a different protocol (such as SFTP), you can choose this option. 

 

Host: Name or IP of the FTP server. 

 

Internet address: Your Website will be accessible at this Internet address (domain 

name). 

 

Remote FTP folder: The remote FTP folder is very important and imposed by your 

provider. You must indicate this folder so as your Website be accessible on Internet. The 

most current remote FTP folders are: www, html, public_html... 

 

Test FTP settings: You can test the WebAcappella access to your hosting thanks to the 

"Test FTP settings" button. 
 

 

 Keywords : Publishing, send my site to my webhosting, configure publication, File 

transfert protocol, domain name, url address, publishing parameters 
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Database management 

 

In order to be able to benefit from some WebAcappella functions (blogs, contact form) it 

is necessary that your hosting manages data bases. 

 
You can choose between two types 

of database: MySQL and SQLite.  

 

 

 

 

 

 

 

Choose depending on what is imposed to you by your host. If SQLite is proposed, prefer 

this type of database that do not require any settings for its use.  

 

Some web hostings directly offer to activate the databases when the account is 

activated, but if this is not the case, go to the “Database” tab and complete the fields 

with the information available on your web hosting’s Web site. 

 

 

 Keywords: Publishing, send my site to my webhosting, configure publication, port, 

SQL, publishing parameters 

 

Manage email properties 

 

This tab allows you to modify the PHP mail function properties. Default parameters 

are applied (except for the email address by default). Change them only if you are an 

expert in PHP coding. 

 

Caution: parameters only for experienced users 
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Default email address: If you do not fill the email field of your contact forms, this email 

address will be used by default. 

 

Variable "Content-type": define the characters encoding (text) of your mail.  

We recommend you to apply defaut parameters (UTF-8). 

 

Variable "From": The corresponding value is an "email" value. The email address filled 

here will be displayed in your email as the email sender. By default, the value will be 

filled with [mail] and correspond to the email address by default. 

 

Variable "Return-Path": This variable is necessary in most hosting services to send 

emails. We recommend you to leave the default settings. 

 

Here are two frequently encountered cases if your host requires additional settings for 

sending email from your website: 

 

Email address of the sender 

Variable: From 

Value: toto@domaine.com or leave [mail] if you already filled the "Default email 

address" field. 

 

Character encoding of mail 

Variable: Content-Type 
Value: text/plain,  charset=utf-8 

 

 

Note: due to numerous possible parameters imposed by different webhosting 

services, there is no support for these parameters 

 

 

Keywords: Publication, publishing parameters, Mail function, Email sending, 

Variable, Value, SMTP, disable PHP mail warning, warning messages, additional mail 

header 

 

HELP ABOUT PUBLISHING 

Publication stopped 

 

- Check your Internet connection 

- Ensure that you have enough room on your web space 

- Check the size of your files (limits on file sizes for certain web hostings, 2 Megabytes or 

4 Megabytes for example).  
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Changes not implemented 

 

- Wait for a while. Depending on how busy the network is, the updates are implemented 

more or less quickly. You can also empty your navigator’s cache 

- Click “Refresh the website” to update the changes that have been made 

- Ensure that you have enough room on your Web space  

There are elements missing 

 

- Check the size of your pages 

- Check the compatibility of your Internet browser with the elements in question 

The publication does not start 

 

It is probable that your web hosting is experiencing a temporary problem.  

Different errors can be displayed in this case: 

- Wrong password / Password  

- Folder / dossier does not exist  

- Connection interrupted  

Do not be concerned with these errors, and try again later. If the problem persists, do 

not hesitate to contact your web hosting.  

The publication is blocked on the first file 

 

- A Firewall type protection can prevent the software from operating correctly 

- Some other security tools can also block publication 

 

If you are not sure of yourself, ask for advice from an experienced person, but it is 

always important to have an active firewall when you are connected to Internet.  

 

For any other problem, please ask the customer technical service from your customer 

space www.webacappella.fr/customer_space_fr.html or the help page of WebAcappella 

Web site www.webacappella.fr 

 

 

 

 Keywords: publishing parameters, connection, help, web hosting, fire wall, Publish, 

Local, xdsl, proxy, web browser, browser version, stop, trouble 

 

 

 

 

 

 

http://www.webacappella.fr/customer_space_fr.html
http://www.webacappella.fr/
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RIGHT CHOOSE A WEB HOSTING SERVICE 

Generalities 

 

In order to place your site online, you should choose a supplier. WebAcappella is 

compatible with a large number of the web hosting suppliers. See the special 

characteristics of web hostings for the ecommerce version: 

http://www.webacappella.com/ecommerce.html 

 

Make the right choice for your web hosting 

 

According to your Internet site’s use (personal or professional), your needs will be 

different. In fact there are numerous hosting solutions (free and paying), and each of 

them have their own features to be able to better adapt to your requirements and your 

budget. We thus advise you to properly consider the solution that is best adapted for 

your requirements. 

 

The different types of hosting 

 

Integrated to your Internet subscription 

When you subscribe to an Internet service supplier, it generally makes a personal Web 

space available to you. Ask your provider for information concerning the access and 

usage conditions for these Web spaces. Most of the time this service is free and 

integrated to your subscription. This hosting solution is very useful to publish your first 

WebAcappella site, but it has usage limits (slow connection, ads, small storage space,…). 

 

Paying 

The most efficient and stable solution is to choose a paying web hosting.  

With rates beginning at €1 or €2 per month, choosing a paying web hosting will avoid 

many publishing and accessibility problems.  

A paying web hosting will also provide you access to more functions and advantages.  

A paying hosting supplier will allow you to choose your own domain name (e.g. 

http://www.mywebsite.fr), to create email accounts associated with your site (e.g. 

contact@mywebsite.fr), to benefit from more storage space...  

We strongly recommend a paying web hosting service type Linux....  

 

Free 

You can also find many web hostings who will offer you free hosting solutions. These no-

charge services are not offered without some considerations. In fact, these solutions 

usually offer limited functions, include ads, offer limited storage space, and the 

connection is not always the best quality. The only advantage offered by free web 

hostings is therefore simply that the service is free. 

 

Keywords : Web hosting, Publishing 

http://www.webacappella.com/ecommerce.html#anchor-setup
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MANUALLY PUBLISH YOUR WEBSITE USING A FTP SOFTWARE 

To publish your web site manually using an FTP program you can do the following 

procedure on WebAcappella. Caution: reserved for experienced users.  

 

- Click on "Files" / "publishing parameters" 

- Then, click the "Advanced" button 

- In the “Local publication” window, create the folder in which your Website will be 

published 

- Then click twice on "OK" and finally on the "publish" button, all the files will be placed 

on the choosen file. 

 

Now, you just have to transfer all files and folders in this folder to your host using FTP 

software (eg FileZilla). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- At the top, fill in the "host", "username" and "password" fields 

- Click the "Quick Connect" button, the folder list on the right central panel will then be 

updated 

- On the left panel, navigate to find the folder where you published your site 

- Drag the contents of the left panel in the right panel 

- Wait for the upload 

- Your website is available. 

 

 

Note: do not forget to include the hidden files (as HTAccess) 

 

 

To view your Website, launch your browser and type the URL of your Website. 

 

Keywords: File Transfer Protocol, filezilla, Cyberduck, local, publish manually, 

publication problems 
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TECHNICAL REQUIREMENTS 

E-commerce 

 

The E-commerce version requires the activation and management of many settings and 

configurations on the web hosting servers, please visit this link for all details: 

http://www.webacappella.com/ecommerce.html 

 

Blog 

 

Your blogs or guest books are active only when online (just like as the web 

administration of messages). To use them, the "MySQL" or "SQLite" functions need to be 

activated on your Web hosting service. 

 

Contact form 

 

The use of the contact form necessitates activating certain functions of your Web 

hosting.  

- Activating PHP (computer language for Web Server programming) 

- Activating the “Mail Function” in PHP (which will allow transferring emails from your 

Web site to your mailbox).  

 

Note: Ask your web hosting to see if these functions are implemented in your 

hosting service. 

 

 

 Keywords: Limitations, technical information, e-market, shop, database, hosting 

activated services, hosting settings 

 

 

LIMITATIONS OF THE FREE EDITION 

SEO 

The Free edition does not allow the page per page SEO. 

In this edition, the titles of the pages will only be used 

for search result display. 

Multilangage The Free version is limited to 2 languages. 

Pages You can only create 8 pages per website. 

http://www.webacappella.com/ecommerce.html#anchor-setup
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Photo album You can only insert 12 photos in each album. 

Multimedia elements You can not add files bigger than 1,4 Mo. 

E-commerce E-commerce is only avaluable on test version. 

 

 

 Keywords: Limits, trial edition, trial version, compare versions, restriction, free 

 

LIMITS FOR USING WEBACAPPELLA IN SOME WEB BROWSERS 

To enjoy all the WebAcappella features, we recommend using the latest update of 

your favorite web browser.  

Some effects such as drop shadows, opacity of the images or rotations can be poorly 

managed or not managed at all with old browsers (such as previous versions of 

Internet Explorer 9). 

 

 

 Keywords: Limitations, internet browsers, IE9, Chrome, Mozilla Firefox, Opera, 

displaying problems 

 

 

IMPORT YOUR WEBACAPPELLA 3 WEBSITES  

ON WEBACAPPELLA 4 

On the first start up of WebAcappella 4, the application checks if WebAcappella 3 

websites are present on your computer and suggest you to import them. 

 

Simply click on the "Import WebAcappella 3 Websites" button. 

 

This action will not affect your WebAcappella 3 Websites. All of them and the application 

itself will not be modified or deleted.. 

All the files and sub folders of the "WebAcappella" folder will be copied and pasted into 

a new folder called "WebAcappella4". You will be able to continue working on your 

Websites. 

 

Note: An adaptation work is certainly to be expected. Some elements have been 

redesigned (audio and video elements, buttons, photo album, e-commerce), somme 

effects have been made unavailable (blur) and other effects and features have 

emerged (Google Web Fonts, text as image...). 
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To manually import your WebAcappella 3 Websites on WebAcappella 4,  

close WebAcappella and follow these steps: 

 

- Copy all the folders present on the /.../Mydocuments/WebAcappella folder 

- Open the /.../Mydocuments/WebAcappella_4 folder and paste all these folders 

- Launch WebAcappella 4, your Websites are available.. 

 

Keywords : from WebAcappella 3 to WebAcappella 4, import site, previous version, 

transfer old site, migration, website project, WebAcappella files, recover 

 

FREQUENTLY ASKED QUESTIONS 

Installation 

 

Compatibility  

Check that you have installed the version corresponding to your operating system 

(Windows or Mac). Update your system. 

 

Updates 

WebAcappella automatically detects new updates. We advise installing these updates. 

To check if updates are available, you can also click on the "Help" menu and "Check 

application updates". 

 

 

Creation 

 

Images compression 

WebAcappella compresses images so they take less space on the Web space. You can 

adjust the quality and the size of the images on your site using the “Preferences” 

menu.  

 

Page size 

You can adjust the width and the height of your pages so they can be better adapted to 

their content.  

 

Templates management 

A template can not be modified in a page. Changes must be done directly on the 

templates througout the "templates" explorer.   

 

I have lost my work 

WebAcappella automatically saves your site in the folder C://Mes 

documents/WebAcappella4 (Documents/WebAcappella4 for a Mac). 

For more security, we advise you to make regular backups of your work. 
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Installing a new font 

On a Mac: 

- Download the font on your computer 

- Double click on the font icon and click on the "Install font" button 

- Your font is automatically installed on your font library. 

 

On a PC: 

- Download your font and copy the .ttf file 

- Paste it on the "Font" folder located on C:/windows/ 

 

Once you have done it, your font is installed on your font library. 

 

Publication 

 

Publication stopped 

- Check your Internet connection 

- Ensure that you have enough room on your Web space 

- Check the size of your files (limits on file sizes for certain web hostings, 2 Megabytes or 

4 Megabytes for example) 

 

Changes not implemented 

- Wait for a while. Depending on how busy the network is, the updates are implemented 

more or less quickly. You can also empty your navigator’s cache 

- Click “Refresh the website” to update the changes that have been made 

- Ensure that you have enough room on your Web space 

 

There are elements missing 

- Check the size of your pages 

- Check the compatibility of your Internet navigator with the elements in question 

 

The publication does not start 

It is probable that your web hosting is experiencing a temporary problem.  

Different errors can be displayed in this case: 

- Wrong password / Password  

- Folder / dossier does not exist  

- Connection interrupted  

Do not be concerned with these errors, and try again later. If the problem persists, do 

not hesitate to contact your web hosting. 

 

The publication is blocked on the first file  

- A Firewall type protection can prevent the software from operating correctly 

- Some other security tools can also block publication.  
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If you are not sure of yourself, ask for advice from an experienced person, but it is 

always important to have an active firewall when you are connected to Internet.  

Internet.  

 

For any other problem, please ask the customer service from your customer space 

http://www.webacappella.com/customer_space.html or the help page of WebAcappella 

web site http://www.webacappella.com 

 

 

Keywords: FAQ, publishing, install, images quality, page size, publishing parameters, 

publishing problems, help, web hosting, local, running WebAcappella, connection, 

fire wall, Publish, Local, xdsl, proxy, web browser, browser version, font 

 

 

  

http://www.webacappella.com/customer_space.html
http://www.webacappella.com/
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THE WEBACAPPELLA 

WORK ESPACE 
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THE WEBACAPPELLA’S WORKSPACE 
DISCOVER YOUR TOOL OF WEBSITE’S CREATION  

 

THE WEBACAPPELLA INTERFACE 

Icon bar 

 

The icon bar allows you to access, the main functions to create and publish your page.  

 
These icons facilitate navigation in the WebAcappella interface.  

 

- Save icon: allows you to save your work 

- Resources icon: allows you to access to the files and images libraries of your website 

- Button icon: allows you to create a button 

- Image icon: allows you to insert an image 

- Text icon: allows you to insert a text area 

- Photo album icon: allows you to insert a photo album 

- Color icon: allows you to create a color zone 

- My shop icon: opens a menu giving access to install the shop 

- Back Office icon: gives you access to the admin of the shop 

- "Arrow" icon: opens a menu giving access to all the elements available on 

WebAcappella 

- Preview: allows you to test your site on the browser of your computer 

- Publish: allows you to publish your website on Internet (publishing parameters must 

be filled-in) 

- Visit: allows you to access to your website (already online). 

 

 

 Keywords: button, icon, interface, toolbar, top 
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Page / template navigation 

 

Thanks to the Page/template navigation, you have access to all your WebAcappella site’s 

pages and templates..  

 

 

You can rename the pages, sort them into folders, delete 

them or add a new template to facilitate your Website’s 

creation 

 

Learn more about template 

 
 

 

 Keywords: Pages, Navigation, interface, left 

 

 

 

 

Rulers 

 

The rulers allow you to easily place horizontal and vertical guides to help you align 

your elements. 

 
 

Note: These visual 

markers are only visible in 

creation mode (not in the 

browser). 

 

 

 

3 ways to create or delete a ruler: 

- Double click in the ruler 

- Click / drag / drop from a ruler 

- Right click -> "Add Ruler" / "Delete Ruler" 

 
 

 Keywords: grid, interface, creation help, pixel, graduate 

 

, REPÈRE 
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The work space 

 

The work space is presented in the form of an empty or predefined space (see the 

section on Templates). This space (for which you will have determined the 

characteristics: size, background, etc.) allows you to add the elements made available to 

you by WebAcappella. 

 

The magnetic grid allows you to place the elements in relationship to the reference 

points. These reference points attract the elements and align them with precision. This 

option is very useful to rapidly place the elements in a uniform way. This grid and the 

magnetism can be deactivated at any time (“View” menu).  

 

 

 

 
 

Keywords: creation space, interface, workspace 

 

 

Layers dock 

 

The layers dock allows you to create and manage layers on your Website. 

 

Layers are used to group elements to create a set for a simplified modification of 

elements (eg: combine all the elements of a bar navigation in order to select and move 
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all them in one click or, once their placement in the page is definitive, to lock and make 

them not selectable. 

 

 
 

 

Note: Layer's dock can be detached or attached to the interface with the button at 

the top left corner (double arrow). 

On the same way, you can close the layer's dock. To display it again, go in the "View" 

menu - "Display layer's dock"  

 

 Keywords: Interface, Pages, right 

 

 

Elements inspector 

 

 The elements inspector gives you instant access to the element properties.  

 

By default, when you click on 

an element, the inspector is 

automatically displayed.  

By clicking on the :  icon 

you can display or hide it. 

 

Every action done on the 

inspector is immediately 

effective and visible on the 

element. Moreover, you can 

modify several elements in the 

same time. For example, select 

several color zones. 

 

Thanks to the inspector, you can adjust in the same time the color, the geometry or the 

border for all the color zones selected. 

It is very useful when you want to apply the same properties to numerous elements. 

 

Keywords: elements options, personalizing elements 
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THE BASICS 

Selecting / moving an element 

 

 

WebAcappella makes many 

elements available to you that you 

can add wherever you wish on the 

page you are creating. 

 

To select an element, place your 

cursor over it and make a single left 

click. The selected element will be 

surrounded by a border with blue 

anchors and an icon bar will appear at 

its right side. This bar gives you access to the element inspector and to delete the 

element (red X icon).  

 

Once selected, hold down the left button 

and move the element. Release the left 

click to place it.  

WebAcappella allows you selecting several 

elements at the same time and all the 

elements on a page.  

 

 

Multiple selection 

 

Hold down the CTRL (or cmd on a Mac) and select the elements one at a time.  

The elements will be surrounded in red. In this way you can move the selected group of 

elements.  

 Or you can also from an empty section, hold 

down the left mouse button and move your 

cursor to select a zone and the elements 

which it contains.  

 

By making a right-click (CTRL click on a Mac) 

in a page, you can select all the page’s 

elements by clicking “Select all the page’s 

elements”.   
 

 

 Keywords: Move, Superimposition, multiple selection, selecting elements 
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Resizing and rotation 

 

Resizing 

 
All the elements integrated into WebAcappella can be re-sized. Whether it is a text zone, 

an image, a photo album, a color zone… you can change their size.  

 

Place the cursor in one of the angles or on the side of an element, hold down the left 

button and move your mouse in the desired direction.  

 

- A movement to the left or the right will change the element’s 

width 

- A movement to the top or the bottom will change its height 

- A diagonal movement will change both the element”s height 

and width.  

 

 

On the element inspector, "Geometric properties" tab, you can manually adjust your 

element size.   

 

 

If you wish to reestablish an image original size or ratio (for example, in the case of an 

image has been distorted during a re-sizing), right-click the element and click “Set 

original image size”. In the same way, if you do not wish the image to be distorted, 

right-click the element and check that the “Keep proportion” option has been clicked.  

 

Rotation 

 

It is possible to apply a rotation to the elements. 

 

Select your element, press on the "Control" key (for Mac) or 

"Alt" key (for Windows) and click on the corner of the 

element. A curved cursor appears. 

 

Keep the key pressed and move up or down your cursor to 

apply the rotation. 

 
See Geometric properties 

 

 

Keywords: Select, Resize, changing size, Rotation, Size, Dimension, Proportion 
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Copy, cut, paste, duplicate 

 

The elements (text, images, photo albums…) may be copied or cut, then pasted to the 

page being created, to another page in the current site, or even to another 

WebAcappella site. 

 

- To copy an element, select it and apply the usual keyboard shortcuts (“CTRL + C” then 

“CTRL + V”) or right-click and select “copy”, and then right-click again and select “paste”. 

- To cut an element, make the same operations while changing the shortcuts. “CTRL + X” 

then “CTRL + V”. Or right-click “copy” and right-click “paste”.  

 

You can copy or cut a group of selected elements (see Selecting/moving an element)  

 

- If you want to duplicate an element, left click on the element and click on "Duplicate". 

The element will be duplicated on the same place. Just move it wherever you want. 

 

Note : When you copy or cut an element to past it in the same page, it will not be 

placed on the same location. 

 

But, if you copy or cut an element to paste it in another page, the element will be pasted 

in the same place as its original location. 

 

The use of Templates can be very useful to avoid numerous copy/paste from one page 

to another. 

 

 

Keywords: Copying elements 

 

 

Alignment 

 

When you select one or several elements in your page, you can align them on the 

page and / or against each other. 

 

Once one or more elements are selected, right-click on the element 

or the group of elements, click the on the menu "Align Objects" 

and then select the type of alignment you want to apply. The "Align 

objects" menu is also available from the menu "Disposition". 

 

 

Note: If only one item is selected, the alignment is done on its location on the page 

(eg "Align Center" aligns horizontally the element at the center of your web page). 

 

Keywords: Aligning elements, elements disposition, disposing elements, center, left, 

right, top, middle, bottom 
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Superimposing elements 

 

When your page is being created, you can superimpose the elements and choose the 

order of their appearance.  

 

Thus, an element can be in the foreground or in the background, but you also have the 

possibility of changing the depth for each element using this same menu, which is 

accessible using a single right-click on the element in question. 

  

  

 

  

 

If several elements are superimposed and the background element is difficult to access, 

hold down the CAP key and click the superimposed elements: in this way you will pass 

through the elements. 
 

Keywords: Select, Move, Superpose, Back, Front, Backward, Forward 

 

Undo modifications 

 

Every action (modify, move, remove...) done on a page can be undo. Three methods are 

available: 

 

"Edition" menu 
Click on "Edition" - "Undo (…,action..)" to cancel the last action done. The action's name 

is automatically reported on this menu. 

 
"Show actions history" menu 

The actions history is available from the "View" menu, "Show actions history". 

To come back to a previous action, select an action on the list to come back to this step. 

All the modifications done between the last action and the action selected will be undo.  

 

You can come back to the last action done at any moment. 

 

Shortcut keys 

Modifications can be cancelled with "Command + Z" (or "Crtl + Z" on Windows) keys. 

To restore modifications, use the "Command + Maj + Z" ("Ctrl + Maj + Z" on Windows) 

keys 

 
 

Keywords: cancel an action, redo, changes 
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Save modifications 

 

To save the latest modifications made to your current page, click  on the “Save” 

button».  

You may click on it at any time to record your creation’s steps. 

When you change your page, WebAcappella asks if you want to save the work that you 

have accomplished. 

 

Finally, when your site is published and previsualized, it is automatically saved. This save 

allows you to restart the work on your creation at the place where you stopped. The file 

is saved in a folder for storing WebAcappella sites. This folder is stored on your 

computer at the following address: C://Documents/WebAcappella. 

 

Keywords: changes, recover, saving website 

 

 

Create a backup of your Website 

 

Backup within WebAcappella 

 

WebAcappella automatically saves your work in the folder /Documents/WebAcappella. 

But in order to maintain an additional backup for your work in a folder or on a media of 

your choice, you can make a manual backup of your WebAcappella site. 

 

A backup is very important. We remain you that it is not possible to recover your 

site installed on your hosting, even using an FTP client. The online files are not 

those used to create the site on the software.   

 

To make a backup: 

- Open WebAcappella and choose the site you want to make a backup 

- Click on the "Files" menu - "Backup Website in an archive". Choose or create a 

destination folder (creating a folder allows you to personalize your backup and avoid all 

problems of data compression) and click on "Ok" (we recommend choosing a removable 

media such as a USB key) 

- You can then choose to join or not your connection settings to the backup. Check or 

not the "Join your connection settings to this backup". Finally click on "Yes". 
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- A .zip file (containing your Website) will be created on the selected place. 

 

 

 

 

  

 

 

 

 

 

 

 

Saving from within your operating system 

 

You can also backup all your sites directly from within your operating system’s explorer. 

You only need to copy the “WebAcappella” folder (located in the “My documents” folder 

in Windows and “Documents” on a Mac) and paste it on removable media (USB key, 

DVD,…) or on a partition on your hard disk.  

 

This method is specially useful in many situations: to import all your Website to a new 

computer, to transfer your Websites to a portable computer or simply to maintain a 

backup of all the Websites. To reintegrate your Websites into WebAcappella, it is only 

necessary to overwrite the WebAcappella folder with your backup. 

 

 

Keywords: Save, Back up, Zip, Archive 

 

 

Restore your site from a backup (WebAcappella 3 and 4) 

 

Click on “Restore a Website from an archive” and select your site’s .zip, at the location 

you created the backup. This operation may be carried out from your site under 

construction or from an empty site (in the case of a reformatting / reinstall of your 

system).  

 

You have also the possibility of restarting your site from zero by clicking “New Website”. 

 

 

Caution: This operation will definitively erase the current site 

 

 

 

Keywords: Recover, Save, restart website, backup wizard 
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Page display 

 

WebAcappella gives you the possibility of working with a full screen (menu: “View” - “Full 

screen window” in order to obtain maximum benefit from your computer screen.  

 

Moreover, if you wish to work on the details of your site’s elements (object size, 

alignment,…) you can zoom to 200% or 300%.  
 

Keywords: see details, focus 

 

Add a page 

 

By default, WebAcappella creates a first page named "Homepage”. This page is 

obligatory and can not be deleted. It is the basis for your site and when the site is online, 

it will be the first page (welcome page) for your Web site. 

 

Add new pages simply by using the “Add a new page” button ("+" icon in the navigation 

page) or by using the “Pages/Templates” - “Add a new page” menu. 

 

Any page created can be changed into the home page using the “Pages/Templates” 

menu, “Set as Website homepage”.  See the Free edition limits 

 

 

 Keywords: welcome page, change homepage 

 

Creating hyperlinks 

 

Hyperlinks allow to navigate on your site, to direct your visitors to other sites, to send 

emails, to download files or to change your site’s language. 

 

The hyperlinks can be applied to: 

- The text 

- The images 

- The buttons and the dynamic menus 

- The color zones 

- The frames 

- The multimedia elements 

When your cursor is positioned on an element or on text, the  tab of the inspector 

allows you to access to the hyperlink properties.  

 

Note : For each type of link, (except for emails) you can choose to make it active in 

the current page (changing the page in the current page) or to open it in a new 

Internet page.  
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“Hyperlink to a page from this web site” 

Your web site contains several pages and you want to create a link to one of these 

pages.  

Click on this type of link and the Page/Masters navigation as well as the list of 

thumbnails will appear. Then choose the page towards which the link will be effective. 

The link is in place. 

 

“Link to a file” 

Create a link to a document of your choice.  

Choose a document in the explorer or import one from your computer using the “Add a 

new file” button. If you have made recent changes to your file, select it in the list of files 

and click “Refresh”. Finally choose the file and click on “Open”. 

 

When you click on the link, it will: 

- either open on your Internet browser (ex: pdf file), 

- or open by the appropriate software (ex: Word, Adobe,...). 

 

“Hyperlink to an Internet address” 

A field appears and requests you to “Enter an Internet address [...]”. Complete the field 

with the Internet address towards which the hypertext link will point. Do not forget to 

place “http://” at the beginning of your address so that it will function properly. If you 

choose to open the link in a new window, a balloon generated by WebAcappella will 

allow you to open this window without being disturbed by the anti popup system in your 

Internet navigator. 

 

“Hyperlink to an Email address” 

The link sends an Email to the indicated address.  

Complete the field with the desired Email address. When this link is clicked, visitors of 

your site will be able to send an email to the defined address.  

 

“Change language” 

Available only on sites on which the multilanguage option has been activated.  

Once the site online, you can allow changing the language by using this option.  

Choose the link’s destination in these pages (current window or new window, bottom or 

top of the page), and then choose the language in the dropdown menu. This link will 

change your site’s language (the navigation will then take place in the language to which 

the link points). 

 

 

Note: Consider placing this type of link on a template of a multilanguage site to 

facilitate changing the language. 
 

Keywords: Element, Hypertext link, link to another website, sending an email,  

link tab 
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Test your Website 

 

During creation process, you can preview your work in the default Internet 

navigator by clicking on this button 

 

This function allows you to view the final result, check the links are working properly, 

check the image displaying, the graphical appearance or navigation.  

 

Every time you test your site, it is automatically saved.  

 

 

Note : Some elements do not work during previewing (blogs, contact forms).  

 

Keywords: Test button, view my site, save my site 

 

Publish your Website 

 

Before launching the publication, ensure that you have correctly entered the 

publication parameters for your WebAcappella site (see Configure your 

WebAcappella Website).  

 

Click on the “Publish” button to place your site online or for each modification of your 

site. Publication will be automatically launched. A window opens and displays the file 

transfer progress.  

 

For each modification of your site, consider publishing it so it will be up to date online. .  

 

Note: Publishing your site online or modifying your site can take a while. Be patient!  

 
When the publication of your site is finished, the window will give you a summary of the 

information concerning your WebAcappella site:  

- Address where the site can be consulted 

- Number of files modified 

- Size of the Website 

 

Keywords: Local, FTP Software, update site, put online, put on Internet 

 

Visiting your Website 

 

You can visit your site at any time by clicking the “Visit website” icon. 

You will then be directly forwarded to the welcome page of your WebAcappella 

site. 

 

Keywords: See my site online 
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TO GO FURTHER 

Organizing the pages 

 

 When you create a site that contains many pages, the pages navigation makes the 

organization and your pages management easy. 

 
Folders 

WebAcappella allows you to regroup several pages in 

the same folder in order to sort them by theme and 

access them rapidly.  

For example: “Photo page” folder, “Project page” 

folder, “Purchase page” folder, …  

 

 

 

Click on the  icon to access the menu. Then click on "Create new folder" and drag 

and drop your pages into the folder.  

 

Rename 

You can rename your pages and folders. The names given in the page navigation will not 

influence the page name on your online Website. 

 

To rename a page or a folder 

- Select a page or a folder 

- Just click again on it or open the  icon and click on "Rename" 

- Give it a name. 

 

Change the Website homepage 

The first page displayed when you open your work is the homepage of your Website. If 

you want to change the homepage, just select the page you want to set as the website 

homepage. 

Then, click on the  icon and click on "Set as Website homepage". The page 

selected will automatically be set as the homepage of your Website (on the next 

publication). . 

 

Limits of the Free edition 

 

Keywords: manage the pages, pages explorer, color marker, change homepage, 

change the name of a page 
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Templates 

 

Templates allow you to give a uniform visual style to all your site’s pages. 

Using templates, the layout will be simplified and your Website will have a uniform 

appearance (no offset in the menus or the recurrent elements on your pages). 

 

Moreover, if you wish to make graphic or contextual changes, simply change the 

template. The changes will then be made on all the pages using this template.  

 

Creating a new template 

To create a new template, click on the  icon in the template navigation (on the left) 

and click on "Add a new template". You can add a new template from the menu "Pages 

/ Templates" and "Add a new template". 

 

A new page called "New template" will be added in the template navigation. 

 

Create your template. It can, for example, be made up of images, color zones, dynamic 

menus and buttons. This composition will be saved as a template and may be used as a 

basis for the creation of pages on your site.  

 

A colored marker will be automatically assigned to your template. When using this 

template on a page of your Website, the color marker will be added to your page, 

allowing you to easily identify the template used. 

 

Integrating a template to your page 

 

Once your template has been created, you can apply it 

to your pages.  

In the page being created, display the page properties. 

In the “Background” tab, click the “Use a template as 

background” box. Select your template and click “OK”.  

 

The template will be applied to your page’s background. The color symbol of your 

template appears on the left side of your page name. 

You cannot make changes directly to your template while pages are being created. 

Return to your template to rework it. 

 

The changes will be reflected on all the pages using this template.  

 

See also: Footers 

 

Keywords: page model, page desing, color sign, color square, uniform design, 

footers 
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Layers 

 

As seen before, layers are used to group elements to create a set for a simplified 

modification of elements (eg: combine all the elements of a navigation bar in order to 

select and move all theme in one click or, once their placement in the page is definitive, 

to lock and make them not selectable). 

 

 

Actions available on the layers dock and their function: 

 

- Add a layer: add a new blank layer in the layer list. 

- Add to layer: add the selected element(s) in the workspace to the current layer. 

- Lock the layer: the elements contained in a layer will not be selectable in the workspace 

(to prevent moving or deleting them). 

- Isolate the layer: to isolate an element or a group of elements of a layer (you wont be 

able to select the rest of the elements in your page). This function allows you to change 

the parameters of elements available in this layer (size, border, opacity...). 

- Associate layers: Select two or more layers and click this button to associate them. 

Select or move one of these layers will impact other layers involved. 

- Ungroup the elements: ungroup the elements available on this layer. 

- Delete the layer: remove the layer and the element that have been added to this layer. 

 

See also the layers dock 

 

Keywords: Pages, layers dock 

 

 

Footers 

 

The footers on WebAcappella work in the same way as the templates 

 

Footers are useful to create the footer of your pages. Links to legal notices, contacts, or 

the copyright may be integrated in the footer. 

 

 

To create a footer, add a new template (you can name it “page footer” to recognize it) 

and create your design by adding elements (buttons, links). 
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- In the, “Page background” tab, “Page footer” section, click on “Choose a page 

footer”.  

 

 

  

 

 

 

 

 

 

 

 

Select your footer in the list of templates and then click “OK”.  

 

 

Note: The footer does not appear during the creation. You can only see it when 

previewing or online.  

The footer will automatically adapt to the height of your page and will be placed just 

after the last element, at the bottom of the page.  

 

Caution: If you use a template in a page, apply the footer directly to the template. It 

is impossible to apply a template and a footer at the same time. .  

 

See also: The templates 

 

 

Keywords: Page model, page desing, color marker, uniform design, page bottom 

 

 

 

Language bar 

 

 WebAcappella also allows managing multi-lingual Internet Websites.  

 

The language bar allows you to move easily from one language to another while the site 

is being created.  
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This bar is only displayed when multilanguage is activated on your Website. 

 

See also: Multilanguage 

 

 

Keywords: Language buttons, manage languages, changing languages 

 

 

MANAGING RESOURCE’S LIBRAIRIES 

File library 

 

The icon  allows you to access to the file library. 

 

This tab allows you to manage the files that you have integrated in your WebAcappella 

Website. You can rename them, delete them or file them in folders.  

 

To add files to your Website’s file library and to access them, click the “Add files from 

your computer” button.  

 

Clicking the "Clean obsolete files" button will delete all the unused files on your 

Website (saving space). 

 

If you carry out changes to a file, select it and then click on “Refresh file” to update it 

(import the latest version of your file from your computer). 

 

Keywords: Managing pdf files, old files, remove files, resources 
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Image library 

 

The icon  allows you to access to the image library. 

 

This tab allows you to manage the images integrated in your WebAcappella Website. 

You can rename them, delete them or file them in folders. 

 

 
To add images to your Website’s image library and to access them, click the “Add 

images from your computer” button.  

 

Clicking the "Clean obsolete images" button will delete all the unused images on your 

Wesite (saving space). 

 

Keywords: Managing images, old images, non-used images, remove images, 

resources 

 
 

PAGE ELEMENTS 

General properties of the elements 

 

Almost all the elements have these common properties: 

 

- Geometric properties 

- Background properties 
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- Opacity 

- Border effects 

 

Geometric properties 

 

These options are available in each element inspector. You can precisely adjust the size 

of your object and its position on the page. Moreover, you can adjust the rotation of 

your element.  

 

x: Distance from the left border of the work zone 

y: Distance from the top of the work zone 

Width: Element’s width   

Height: Element’s height 

 

By checking the "Keep proportion" box, the element 

ratio will be the same if you enlarge or reduce the size 

of your element. 

 

Finally, you can adjust with precision the angle of 

rotation. 

 

 

 

 

Keywords: dimensions, location, place, size, spinning 

 

 

Element background properties 

 

The “Background properties” tab will allow you to choose an image or a background 

color for personalize your elements (text zone, color zone, photo album…).  

 

 

 

Color gradient 

To apply a color gradient to the background of an element, activate it by clicking on the 

“Gradient” box. Choose the colors for the gradient (you may choose the degree of 

opacity for the colors or simply make a gradient 

that tends to transparency).  

Once the colors have been determined, you may 

move the cursor to adjust the orientation or the 

intensity of the gradient 

 

Keywords: change color 

 



WebAcappella 4 user’s guide – July 2014 

 

Copyright Intuisphere® - All rights Reserved  47 

Element opacity  

 

Each element can be made more or less opaque. 

 

By default, the element is 100% opaque, but you can 

adjust its transparency by moving the cursor to the left or to the right.  

 

Keywords: Element properties, Background 

 

Element border 

 

You can assign a border to many elements.  

 

It is possible to vary the four corners with separately and the thickness (expressed in 

pixels). 

 

    
 

Shadows 

Add a shadow to your element and configure its color, its angle, its offset and its opacity: 

 

Sample 1 

 
 

 

Sample 2 

 

   
 

Sample 3 
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Keywords: Element properties 

 

 

Elements 

 

Button 

 

In order to create your links or your menus, WebAcappella makes available navigation 

buttons that can be entirely configured. To insert a button, click the “Insert” menu, 

“Button” or click on that button of the icon bar:  

  

 

General appearance of the button 

In this section choose your button’s general shape (you can parametrize the % of the 

corner). You can decide whether or not to apply a normal, active or over appearance to 

the button. 

  

  

  

 

 

 

 

 

 

 

 

Graphical appearance of the button 

It is possible to determine the appearance of the button in 3 “States”: 

- “Normal” state: Button inactive 

- “Overed” state: When the cursor passes over it 

- “Active” state: When the button corresponds to the page being viewed 
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Background appearance 

Choose a color or a background image for your button. Simply click one or two boxes to 

select a color on the pallet or select an image from your “Resource library”.  

In the same way, you can apply a gradient effect to your button. Choose a color in the 

“Gradient”. 

 

If you let the "Link" box checked, the border colors and the gradient color will be 

automatically selected by WebAcappella (to obtain a gradient tone). If you uncheck 

the "Link" box you can choose the colors you want (to get a customized result). 

 

Caution: If you recheck this box, your custom colors will be replaced by automatic 

colors. 

 

 
 

 

Pictogram 

The “Pictogram” option allows you to insert an image in your button in order to 

personalize it. If you unclick the use of the pictogram in the “Overed state” or in the 

“Active state”, the pictogram for the “Normal state” will then be used by default. You 

choose the size of the pictogram (in %) using the dropdown menus.  
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Text properties 

Choose here the text color for your button. You can make it bold or underline it.  

 

 
 
General properties of the text 

Edit the text of your button. Think about the size of your button and the size of your 

text. 

The "Tooltip" field allows you to add a comment to your button. Once your site is in 

view mode or is online, place your cursor on the button to make a frame appear that 

contains your text.  

Choose your font layout too and the inner margin. 

The inner margin define the place of the text on your button. The more you increase the 

percentage, the more your text will be far from the border of the button. The inner 

margin is useless if the text is centered. 

 
Links 

Hypertext links 

In the “Link” tab, choose the destination of a hypertext link for your button  

(see Hyperlinks section). 

 

Blog function 

 

On each button, you can add a link to the "Blog" function. It will allow your visitors to 

post a message or react to an article or a text of your website. 

 

To activate the Blog element, click on the 

"Link" tab of the button inspector. Then 

select the "Link to blog" menu. Once online, 

you just need to click on the button to post 

a message. 

 

You can display the number of messages in 

your blog by typing % comment(s) in the 

name of your button. You can completely 

customize your message, the % character is 

always replaced by the number of 

comments on this blog. 

 

The "Blog id" field is managed by WebAcappella. On each blog, a single code is 
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generated by WebAcappella. This code will allow you to delete a Blog from a button and 

to transfer messages to another button. Simply copy/paste this code from one blog to 

another. All the messages will be transferred.  

 

See the technical requirements. 

 

Keywords: Element, guestbook, button state, hover 

 

 

Image 

 

 WebAcappella allows you to integrate as many images as you wish.  

 

Click on the “Image” icon or in the “Insert” menu click “Image”. 

 

Click on the "Click here to select an 

image" button in the inspector to add an 

image from your image library (or add 

images to the library).  

 

The "Tooltip" field allows you to add a 

comment to your image. Once your site is 

in view mode or online, place your cursor 

on the image to make a frame appear that 

contains your text.  

 

You can delete this image at any time by clicking the red cross (when the image is 

selected). 

 

Once it is inserted in the work zone, you can resize it, adjust its transparency, and add a 

hypertext link, a border or a reflect (only displayed on your web browser). 

 

In the geometric properties, you can decide to set the image at its original size. Just click 

the "Set original size" button. 

 

 

Image rollover 

 

WebAcappella also gives you the possibility to create an image appearance when the 

main image is being “rolled over”, thus adding a dynamic effect to your pages.  

On the image properties tab “Over”, click “Click here to select an image” and import it 

in the same way as the main image.  

This roll over image may be deleted at any time by clicking the red cross.  
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Note: The rollover is disabled if you use 

the reflect effect. 

 

 

 

 

 

 

 

 

 

Fancybox 

 

FancyBox option allows you to display an enlargement of your image within the page (in 

a floating window). 

 

 
 

 

Enable this option and test your page: you can click on your image to enlarge it. 

 

Note : if a link is applied to your image, the link will be showed in the comment of 

the image when displayed with the FancyBox effect 

 

 

 

 The "Group images in a gallery" option can be used to group the images of your page 

(on images where FancyBox is activated) as a photo gallery. You can create multiple 

groups of images in order to separate or group them (for example images with the same 

theme or the same purpose). The number assigned to each image determine its position 

in the photo gallery (ascending order). 



WebAcappella 4 user’s guide – July 2014 

 

Copyright Intuisphere® - All rights Reserved  53 

 

The "Edit default properties" button sets the rules for displaying your images on 

the FancyBox effect (maximum display size, effect, loop playback, comment). The 

parameters applied are common to all images using FancyBox. 

Limits in some browsers 

 

Keywords: Element, photo, picture, zooming images, fancy jquery, create a Gallery, 

grouping pictures, effects, cursor over the image 

 

Text zone 

 

Add a text zone using the icon “Text” or using the menu “Insert” - “Text”. 

 

 
 

Edit your text by double-clicking on the zone. 

  

Format your text by applying different text editing procedures available: bold, italic and 

underlined, text aligned left, right or centered, changing the color, the size and the 

shadow (not available when the text is converted into an image). 

 

Moreover, you have the possibility to create, change or delete hypertext links (internal 

or external links). 

 

If you wish a text zone to fit into a certain size, but the text is too long, the zone 

automatically creates a vertical scroll bar (you can configure the scroll options). This 

scroll bar can be always visible or hidden (only visible when mouse is over the text). Tick 

the "Hide automatically" box for this visual style. 

 

The text scrolling (vertical or horizontal) is available too. Configure the scroll options in 

the text inspector. 

 

The text inspector allows you to edit others preferences like:  

- Inner margin 

- Links color 

- Border, corner, shadow and opacity 

- Shadow. 

 

Convert text to image 

 

This option allows you to convert your fonts into an image without disturbing the proper 

display of your page (for example, to create the title of your site or title paragraphs). 
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To transform the text into an image, select the text zone and, via the property inspector, 

check the "Convert text to image" box. 
 

Caution: This option disables the links on the text and the scroll too. This feature is 

especially recommended for the transformation titles paragraph or Website name. 

Using this function on all the texts of your site could slow down the display of your 

page when online. Also text as image is not considered by the search engines for the 

SEO. 

 

Using Google web fonts 

 

Only a few number of fonts are compatible with all browsers (Arial, Helvetica, Times, 

Verdana) and available on your visitors computer. 

 

Google web fonts is a service provided by Google. It allows you to use custom fonts on 

your website and ensure that these policies are visible to all your visitors. 

 

WebAcappella thus allows you to use Google web fonts directly into your site. 

 
Find and install a Google web font 

 

- Go to this 

webaddress: www.google.com/webfonts 

- Add to your collection one or several fonts 

you like (by clicking on the button "Add to 

collection") 

- Click on the link "Download your collection" at 

the top of page 

- Click on "Download the font families in your 

collection as a zip-file" 

- Save the file on your computer and unzip it 

- Install on your computer the font(s) contained 

in the folder by double-clicking it. 

 

Use Google web fonts 

 

- The Google web fonts you have downloaded are available in the list of fonts available 

on your computer (and identified by a yellow icon located on the left) 

- You can now use the font in your WebAcappella website. This font(s) will be visible to 

all your visitors. 

 

 

Note: The fonts for the web and the Google web fonts are situated on the top of the 

list and are identified by a yellow icon. 

http://www.google.com/webfonts


WebAcappella 4 user’s guide – July 2014 

 

Copyright Intuisphere® - All rights Reserved  55 

"Heading" tags (H1, H2, H3...) 

 

The use of these tags, for search engine optimization of your texts, is dedicated to 

advanced users with knowledge of SEO. 

 

Geometric properties 

You can precisely adjust the size of your object and its position on the page. 

See the geometric properties. 

 

 

Keywords: Element, picture, Miniature, Slideshow, Principal image 

 

 

Photo album 

 

You can integrate into your Website a configurable photo album / slideshow. Click the 

“Insert” menu - “Add a Photo album”. 

 

    

            Mode normal          Mode pleine page 
 

To customize your photo album, the properties inspector is divided into five tabs: 

- Images insertion 

- Photo album parameters 

- Slideshow settings tab 

- Comment settings tab 

- Geometric properties 

 

See also the Free edition limits 

Images insertion tab 

 

To add images to your photo album, simply click on the "+" icon to import photos from 

your image library. To delete or move images, use the tool bar on the right. You can 

choose the maximum size of your photos too. 
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To edit image properties, double click or select an image on 

the list and then click  

on the    icon on the right.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reframe the image selector thumbnail 

Reframing the thumbnail allows you to select an image zone for the image which 

appears in the image selector. Select a format for the frame and move the zone to the 

desired position on your image. By default, the image is at 100% and trims on the 

borders to form a square and fits to the image selector thumbnails.  

This frame does not affect the image in the viewing zone and in the slideshow.  

The arrows are used to rotate your images (in clockwise and counter-clockwise 

direction).   
 

Add comments to the images 

The description field corresponds to the text which appears in the comment zone. If the 

multilanguage option is activated, you can complete this field with several languages.  

 
Use Flickr album 

To use this option, you must have a user account at Flickr. 

If you have an account and photo albums on Flickr online service, import them easily 

into your Website just by filling out the ID of your photo album in the fields dedicated 

for that purpose (in the property inspector of the photo album). 
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Parameters of the photo album 

 

Choose here the display mode for your photo album 

(classic, automatic slideshow, or scrolling single 

image). Determine the size and spacing between the 

thumbnails, the navigation options, the shadow and 

finally the transition effect between pictures (the 

more the cursor will be placed on the left, the more 

images will fade in). 

 

 

 

Note: In slideshow mode, the comments on your 

pictures are displayed in a single line (wrapping is 

not supported). 

 

 

 

 

 

 

 

 

 Slideshow settings tab 

 

Choose here whether to permit random slideshow of images, the delay between images 

(in seconds) and the display of the slideshow button. 

 

Comment settings tab 

 

By checking or unchecking the "Show Comment" option you choose to show or hide the 

comments. 

Finally, you can choose to show or not customized tooltips for your miniatures. 

 

Geometric properties 

 

You can precisely adjust the size of your object and its position on the page. 

 

See the geometric properties 

 

Keywords: Element, picture, Miniature, Slideshow, Principal image 
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Color 

 

Click on the “Insert” menu, then “Color”. 

 

The color zone appears. You can then re-size it and choose the color or a background 

image.  

 

With its inspector, determine a 

background image and/or a background 

color. Then you can adjust its degree of  

transparency, assign it a border.  

 

Assign a gradient or round corners as well 

as a drop shadow effect. You can also 

adjust the geometric properties. 

 

 

 

 

Note: By adjusting the order of appearance on the page (foreground, background, 

advance, reverse) you can use this element as a basis for a graphic creation for your 

site.  

 

Keywords: Element, graphical composition, superimposing 

 

 

 

Dynamic menu 

 

The dynamic menu facilitates navigation on your site by offering you a system of menus 

and submenus.  

 
Organizing your menu 

To create a new main menu, select “Root” and then click on   

For a new submenu, position the cursor on a main menu and then click on    

 

In the “General properties” window you can rename your menus and sub-menus, and 

then assign a hypertext link to them.  

Reorganize your menu using the “Up” and “Down” buttons. 
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The appearance of your menu 

 

The “Dynamic menu design properties” tab allows 

adjusting the main menu’s and sub-menu’s appearance.  

 

 

 
 

Choose the orientation, the background, the font, the 

menu separator color, the style that appears when the 

cursor passes over the text, the appearances of the 

corners, the border, the geometric properties...  

 

 

Keywords: Element, Button, website navigation 

 

Dynamic frame 

 

Thanks to the dynamic frame element you can create a group of elements on a 

template to use it later on your pages (free placement). Moreover, when you modify 

your template, all dynamic frames that link to this template will also be modified. 

 

To use a dynamic frame 

- Create a new template in the template explorer 

- Create, in the working area, a group of elements that 

you will need to use regularly in your pages (but that will 

be placed at different locations in many pages) 

- In a page of your site, add a "Dynamic Frame" 

- Select the template in which your elements are 

- The content of this template is automatically displayed 

in the dynamic frame that you can place freely in your 

pages. 

 

Keywords: graphical creation, composition, creating an ad 

 

Search engine 

The integrated search engine allows you to 

search for one or several words on pages. 

No special configuration is needed. 
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The only thing you need to do to have custom search results (to display informations 

about pages given in results) is to make the SEO for the pages one by one. See also SEO. 

The texts written in the "Web page title" and "Web page description" fields will be the 

information displayed on the search results. 
To add a search engine, click on "Insert", "Search engine". 

 

Then you can modify the visual style of the search field and the aspect of the text and 

the button. You can also access geometric properties 
 

To make a search, test or publish your website. 

Type a word on the field and then click on the 

search button.  

The search results will be displayed on a new 

transparent window. You can make a new 

search, click on a result or close the window 

 

Note: insert a search engine on a template 

or on each page of your Website to allow 

your visitors searching at any page of your 

website. 
 

Keywords: Element, text searching, 

referencing 

Contact form 

This element allows you to create a contact 

form for your website. 

 

Choose fields you wish to be displayed, the 

appearance of your form, as well as the 

parameters for sending mail.  

 

Note: Figures on the right of each field 

are visual cues that allow you to quickly 

identify the field you want to modify. 

 

 

 

 

The form inspector is divided in five categories 

- The form fields 

- The form fields visual style 

- The form buttons 

- The form bottom visual style 

- The geometric properties 
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The form fields 

Add, delete or move your fields with the buttons available under "Fields management". 

The “Current field” dropdown list will allow you to navigate between the different fields 

in your form.  

Assign the maximum number of characters that can be inserted in the field when 

editing. 

Determine the type of element, and enter its title in the “Element type” part:  

- “Read-only text”: Type a text that will be the title for the zone (example: “Your 

message”).  

- "Email": text that must be formatted as an email address (xxxxx@xxxx.com). 

WebAcappella check the validity of the formatting. 

- “Editable text”: Creates a text zone that will be completed by the user (examples: 

name, first name, Email address,…). You can also write some sample text in the "Default 

value" zone, dedicated to the "Editable text" field. 

- “Wide editable text”: Free text that could be the body of a message sent from the 

form (example: Field where the form’s user enters his message). You can modify the 

element height and the number of characters. 

- "Type list": This kind of field allows you to insert a list. In the "Values list" field, type 

your values separated with commas (example: Mr, Mme, Ms). You can also choose a 

typed value as default value for this zone. Just select it in the "Item selected by default" 

menu. If you wish the field to be mandatory, tick the “Is mandatory” box. 

 
In order to receive the emails sent from the form, complete the fields “Email title” 

and “Email to” with your personal information. 

"Force mail response with form email field": by enabling this option, when you 

receive an email from your website, when you click "Reply" or "Transfer" from your 

email (Gmail, Yahoo, ...) the email address of message will be automatically recognized 

and used as email address reply. 

 

Note : This option is only functional if your form contains a field "Email". 

 

Fields visual style 

You can apply a background color and a border to your fields and modify your text’s 

appearance (“Text label style”). 

 

The form buttons 

The buttons and text color can be modified in normal and over states. You can choose 

the text style too. You can also choose to display the “Reset” button or not. This is used 

to delete all the content entered in the editable fields.  

 

Background 

Choose a background for your form (color/image), border, shadow, and opacity 

 

See technical requirements 

 

Keywords: Element, sending messages, receiving messages 
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Google Maps 

You can easily add Google Maps to your pages. 

Insert the element "Google Maps" and chose its size. Then insert your full address in the 

field dedicated to this purpose in the Property inspector. 

Your map will automatically appear in your page. 

 

Keywords: Element, Map 

 

Products button 

See e-commerce section 

Cart button 

See e-commerce section 

Customer account button 

See e-commerce section 

Currency button 

See e-commerce section 

Sound 

To integrate a sound element to your Website, click the “Insert” menu, then “Sound”. 

 
The sound inspector allows you to: 

- Choose your sound (.mp3 format) from your file library thanks to the "+" button or 

choose an Internet address 

- Choose your player options ("Play at startup", "Loop play" and the "Default volume"). 

 
Note : Votre élément audio est lu en streaming. Ceci signifie qu'il n’a pas besoin 

d’être complètement chargé pour que la lecture commence.  

Free edition limits 

 

Keywords: Element, Music, Audio, audio format, playing music 
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Video 

 

To integrate a video to your Website, click the “Insert” menu, then “Video”. 

You can add videos coming from Youtube, Dailymotion or Myspace. 

 

Youtube Online video 

On Youtube click on "Share" then copy the code on the field "Share this video" and paste 

it on WebAcappella.». 

 

Keywords: Element, online video, film, video format, streaming, vmw, player 

 

Flash animation 

 

You can insert a Flash animation (in SWF format) in WebAcappella.  

 

Click on “Flash Animation”. Give a name to your Flash animation in the "Title" field. 

- Link to an Internet address: enter the complete address for the Flash animation 

- Link to a file: add your Flash file in the file explorer by clicking on “+" button, and then 

select the file thus imported from your computer. 

Experienced users who have created their own Flash animation may modify their 

animation’s configuration using the configuration window for the names and values. 

 

Keywords: Element, player 

 

Frame 

 

A frame is a window inside a page, whose content is independent from the rest of 

the page. It may have the dimensions you want, and it is up to you to adapt its 

content. 

The frame content is automatically displayed on the workspace. 

Different types of links can be applied to a frame:  

 

"Internal page link" 

Select from the dropdown menu “Internal page link”. Choose a page on your Website 

to  appear in the frame.  

 

"Internal file link" 

This link opens the selected file inside the frame on condition that your Internet 

navigator is equipped with the necessary functions to read it (Adobe PDF reader, 

images, .txt files, (simple text),…). In the contrary case, the file will be opened externally 

(outside your Internet navigator) by the software corresponding to the file (Excel, video, 

music,…).  

Select “Internal file link” in the dropdown menu. Then click the “+” button and select 

the desired file.  
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"Hyperlink to an Internet address" 

Your frame will have as its content an Internet site for which you will have determined 

the address. 

 

Note: Think about adapting the size of your frame to the Internet site to which it is 

linked.  

Select “WWW link”, and then type the Internet address in the corresponding field. 

 
Limits on some web browsers 

 

Keywords: Element, displaying documents 

 

HTML anchor 

 

The element “HTML anchor” allows you to create links from one exact location to 

another location in the same pages. 

 

Click on “HTML anchor” and place the element on your page at the desired location.  

Display the element properties with the inspector and assign a name to your HTML 

anchor. 

When you create a hyperlink to the page containing the anchor, first click on the name 

of the relevant page and then click on the drop down menu above under "Target" and 

select the name you gave your anchor to create a direct link above. 

This element is particularly useful when you have very long pages. For example, if you 

create a page containing a long chapter text, you can assign an HTML anchor to each 

title.  

 

Keywords: Element, cross reference, bookmark 

 

HTML code zone 

You can enter some HTML code by yourself and integrate it in the page being 

created (coding and development skills required). 

 

In the “Insert” menu, click on “HTML code”. 

Enter your code in the window provided for this, and tick the “Enable HTML code 

below” box. Place your zone in your page (in certain cases, remember to adapt the size 

of the zone to the code content).  

 

Note: Some HTML codes may disturb your Website displaying 

 

Tips: "$wa_var.LANG" This variable can be used anywhere in a code and will be 

replaced by the code language of the current page (experienced users). 

Limits on some web browsers 

 

Keywords: Element, add functions, developer, adding code 
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WEBACAPPELLA 

PREFERENCES 
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PARAMETERS 

HOW TO SETUP WEBACAPPELLA 

 

WEBACAPPELLA PREFERENCES 

General preferences 

Images preferences of your Website 

Internet browser 

Application language 

Magnetic grid 

 

 

General preferences 

 

This tab allows you to modify the design of the application and the folder where your 

Websites will be stored. 

 

  

  

 

 

 

 

 

 

Modifying the Web spaces storage folder is reserved for experts. It is useful to store 

your Web spaces elsewhere than in the System partition.  

 

Keywords: save projet, software parameters 

, project folder, WebAcappella parameters 

 

 

 

Image preferences of your Website 

 

Here you can choose the compression ratio for the Website images. 

 

By default it is 80%, which is a good compromise between visual quality and image size 

(for no deterioration in the quality, choose 100%).  
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Also determines the maximum size for an image on your site.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adjust the size of the jpg images 

When you publish your JPEG images, they are compressed with the values determined 

on the options (e.g. an original JPEG image is imported without any compression and if 

you publish it with a 70% quality, its size and quality will be reduced). 

You can determine the optimal quality by making different tests.  

 

Maximum size for your images 

You can set the maximum size of the images added on your project (by default with a 

1024x1024 size). 

When you import images on your project, if their size is bigger than the maximum size 

set in the option, they will be automatically resized. This option has no influence on the 

visual of your images. 

 

This option is useful to optimize the size of your project and backups. We suggest you to 

let the default size. 

 

File format for drag&drop images 

By default, WebAcappella imports your dragged and dropped images (for example from 

your Web browser) in the JPEG file format. 

In this window, you can choose the PNG file format as the default file format for your 

images. 

 

If you tick the "Always show choice dialog" box, each time you import an image, 

WebAcappella will ask you which file format you want to use. 

 

Keywords: software parameters, photos size, images format, pictures, WebAcappella 

parameters 
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Internet browser 

 

The “Web” section allows you to choose the Internet browser that WebAcappella will use 

to carry out previews and for navigating on Internet.  

 

 

  

 

 

 

 

By default, WebAcappella is configured to use the default browser of your system.  

 

Keywords: Software parameters, WebAcappella parameters, choose a browser 

 

 

Application language 

 

 You can choose here your application language. 

 

  

 

 

 

 

 

 

 

 

 

By clicking on "OK", the language will be switched. 

 

Tick the "Enable the spell checker" box to allow WebAcappella to check the spelling of 

typed words. Note : this option is only available on Mac… 

 

Note : This option is only available on Mac. 

 

Important : If multilanguage management is not active, check the default language 

of your Website. If you write in English, "English" must be the selected language 

in the default website language option. 
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Magnetic grid 

 

Manage the position and attraction between elements. 

 

 

 

 

 

 

 

 

Choose the number of points to display on the magnetic grid. The higher number of 

steps, the more spaced out the points will be. 

 

Keywords: Software parameters, WebAcappella parameters, placing elements 

 

 

WEBSITE PROPERTIES 

SEO 

Activate and use multilanguage 

Pages protection 

Advanced functions of the web properties 

Apache settings 

 

SEO 

 
With WebAcappella, you can 
manage the SEO of your website. 
 

A good SEO will give a better visibility 

to your website on Internet. Fill in 

the fields with your information and 

tick the "Automatic Site Map 

management" box. 

 

SEO can be done either in the 

website properties either in the page 

properties. We strongly recommend 

to work both parts. 

 

- Website: Click the “Web site” menu, 

“Web site properties”. 

 

Note: Only the website homepage (index.html) could not be changed. 
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The field "Web page default title" or "title" tag is showed first on the search engines. 

This tag is also used when you add a website to your favorites. We recommend you to 

use only 60 characters (including spaces). 

 
The field "web page description" or "description" tag appears under the title in the 

search engine results. It describes in two or three sentences the content of the page. It is 

souhaitable to make a different description for each page. Use 160 characters 

maximum. 

 

The field "Keywords used by web search engines" or "keywords". Complete with 

keywords in reference to your pages content (e.g. website creation, WebAcappella,…). 

This tag is today less used by search engines. 

 

See also Free edition limits 

 

 

Sitemap 

 

A XML Sitemap is a list of the pages of your website.  

Sitemaps are a way to tell Google about pages on your site that might not otherwise 

discover by google's robots. 

 

Most common uses of a sitemap: 

 

- Your site has pages that aren't easily discovered by Googlebot during the crawl 

process. E.g. pages featuring rich AJAX or images. 

- Your site is new and has few links to it. Googlebot crawls the web by following links 

from one page to another, so if your site isn't well linked, it may be hard for Google to 

discover it. 

- Your site has a large archive of content pages that are not well linked to each other, or 

are not linked at all. 

 

 

Google Analytics 

 

To access to Google Analytics, go to the following link 

www.google.com/intl/en_uk/analytics then click on the Sign in link on the top right of the 

page. 

 

If you already own a gmail account, type your login and password, otherwise, you have 

to create an account (follow the instructions on the screen). 

 

Google Analytics Setup 

 

First you need to declare your website in the admin section on the google Analytics 

http://www.google.com/intl/en_uk/analytics/
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website. Click on the new account button, then Website and fill all the fields. 

At the end you will get an ID, a code like: UA-XXXXXXXX. 

 

In WebAcappella, go in the "Website menu", then "Website properties" and paste the 

ID in the field under "Site Statistics" section. Click on "OK" to finish. Publish your 

website, in a few days the first statistics of your website will be available. 

 

 

  

 

 

 

 

 

 

Keywords: Referencing, web site properties, xml file, website traffic, meta tags 

 

 

Activate and use multilanguage 

 

With WebAcappella you can make a multilingual website by activating the 

multilanguage management. 

 

Activating the Multilanguage option on a WebAcappella site in two steps: 

 

Activate multilanguage management 

for the site 

 

 Click on the “Website” menu - 

“Website properties”, “Language” 

tab.  

 

Then click the “Activate 

multilanguage management” box.  

 

Choose the languages you wish to 

use (you can add and remove them, 

and determine their priority).The first 

language in the list will be the 

language displayed when accessing 

the home page of your website. 

 
The first part of this window allows you to choose the language (default website 

language) applied on some elements like buttons of the contact form ("Send" or "Reset" 

buttons). 
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Activate multilanguage on the pages 

 

In the page being created, display the page properties (right-click - “Page properties” or 

the “Page” item). Go to the “Multilanguage” tab. By clicking the “Activate 

multilanguage on the current page” multilanguage will be activated. By default, the 

box is not checked and the page will be edited in the default language. 

 

 

 

 

 

Change from one language to the other by using the language bar.   

 

 

 

 

Note : If you have already entered text and you wish to make your site multilingual, 

proceed with the two previous steps (the text will disappear) and then right-click on 

the page. Click “Complete the text on the page using another language”. In the 

window that appears, click on “default” to redisplay your original text.  

 

See also free edition limits 

 

Keywords: Page, Default language, language buttons, manage languages, multi-

lingual website 

 

Pages protection 

 

WebAcappella gives you the possibility to restrict access to your pages with a password 

or to protect their content by preventing the right click. 
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Protect a page with a password in two steps: 

 

- Display the Web site properties (“Website” - “Website properties”). In the “Page 

protection” tab, complete the field with the password of your choice. At any time you 

change this password do not forget to inform your visitors. 

 

- Display the page properties that you wish to protect with a password. In the “Page 

protection” tab, click the “This page is protected by a password” box. When your site 

is online, or in preview mode, a dialogue window appears requesting you enter a 

password. Complete the field with the password you have chosen and then click on 

“OK”.  

 

Content protection: prevent the right click 

 

If your site includes text or images protected by rights, with WebAcappella you can 

prevent the use of the right click and text selection on your pages.  

Display your Website properties, and in the “Page protection” tab, tick the “Block right 

click on your pages” box.  

 

Keywords: security, copyright 

 

 

Advanced functions of your website properties 

Code HTML 

 

This tab allows you to add code in 

the “Head” section of the HTML page 

that is generated by WebAcappella 

(reserved for experienced users). 
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Favicon 

 

The "Favicon" is a small picture that will be displayed on your Internet browser, next to 

your website Internet address. The favicon can be displayed on the left part of a browser 

tab too (for browsers supporting tabs management). It can be for example your 

company logo. 

 

We recommend you to choose a square picture in order to avoid distortions. 
 

Screenshot management 
 

This tab allows you to manage screen captures which can be used when your site is 

registered in the WebAcappella directory or in any other site using the “Ascreen” 

system.  

WebAcappella uses by default an automatic screen capture from your site’s main page. 

By unselecting “Automatic management” and clicking “Choose a screenshot”, you can 

choose your own image. This image is recorded in the “ascreen.jpg” format. 

 

Page generation 

 

Force IE7 rendering with IE9 

 

On Internet Explorer 9, when a Website is displayed in a frame with a transparent 

redirection, navigation problems may occur. 

Use this option to work around this limitation of Internet Explorer 9. We recommend 

you to leave this box unchecked. 

 

Use the UTF-8 character encoding for the Head tag 

 

By checking this box, the character encoding of your head tag will be converted to UTF-8. 

The accented and special characters (such as é, à, ê, &, $, ...) will be displayed in the 

source code of your page (some web hosts do not have this option). 

 

 

Keywords: internet browser, coding, development 
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Apache settings 

 

Used on security and access purposes, these settings are only dedicated to users with 

good skills in coding and web development. 

 

For more information about these features, please visit the link below: 
en.wikipedia.org/wiki/.htaccess 

 

 

Keywords: HTAccess, HTPassword 

 

 

PAGE PROPERTIES 

WebAcappella allows you to customize the properties of your pages. 

You can for example enhance the SEO of your site, change the background of the page, 

or insert a template... 

 

- SEO 

- Background and size of your page 

- Protection of your page 

- Multilanguage 

- Advanced options 

 

SEO 

 

Pages: Each page on your Website may be referenced independently. In each page 

(double click on the page or "Pages / Templates" - "Pages properties", “SEO” tab. 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/.htaccess
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This tab also allows you to modify the HTML file name (page name) and thus replace the 

title «crbst_xx» by a name of your choice (e.g. contactpage or photoalbums). It is 

essential not to use spaces or special characters.  

 

You can work on SEO of your site in various languages by changing the language thanks 

to the dropdown menu. 

See more details on:  website SEO and H1 tags 

 

Free edition limits 

 

Note: Only the website homepage (index.html) could not be changed 

 

Background and page size 

 

 You can choose the color or the background image for 

your current page.  

 

 

 

 

 

Repeating an image as page background 

- Repeat horizontally: your image will be repeated across the width of your page 

background 

- Repeat vertically: your image will be repeated throughout the height of your page 

background 

Combining these two types of alignments gives a mosaic effect. 

 

Background alignment 

- Default: the image will be aligned to the left of your workspace 

- Left: the image will be aligned on the left of the page background (it will move along 

the width of your browser window) 

- Centered: the image will be aligned in the center of the workspace AND the 

background of the page. 

 

Option "Fixed background": Your page background does not scroll when you scroll the 

contents of your site. 

 

Caution: Enable this option can degrade performance display in WebAcappella AND 

in your Internet browser. 

 

Your page size 

Determine the size and the height of your pages using the dropdown menus. If the 

suggested sizes are not suitable for you, you can enter a value yourself by typing it 

directly into the field. 
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If you wish your Website to be centered, 

ensure that the option “Desktop centered 

during publication” is checked. In the 

contrary case (website to the left of the 

window) uncheck the box 

 

Note: The element placed at the lowest point on the page will determine the end of 

your page, and consequently the end of the vertical scrolling. 

See also the Templates 

 

Keywords: Page properties, page design, work space, Image, photo, picture, page 

height, page width. 

 

Page protection 

 

This tab allows you to protect 

the access to your page using a 

password.  

Tick the box to protect your 

page using a password. 

 

The password is determined in the Website properties. 

 

 Keywords: security 

 

Multilanguage 

See: Activate and use multilanguage 

 

Advanced properties of your page 

 

This tab allows you to add code in the 

“Head” section of the HTML page that is 

generated by WebAcappella (reserved for 

experienced users). 
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Page under construction 

 

If a page of your Website is not ready to be published you can choose to hide it once 

online. Just tick the "Do not not display the content of this page once online" box. 

 

Keywords: Page properties, code, page unfinished 

 

 

ADVANCED FUNCTIONS 

Refresh your Website 

 

Refreshing your WebAcappella site will allow you to completely regenerate it. 

“Web Site” menu “Refresh the Web site”. 

 

 
 

This function is especially useful when the Website has been erased or modified outside 

WebAcappella (using FTP, for example).  

Also, you can refresh your site after a publication, or if problems have been noticed (for 

example if files are missing or the display is incomplete).  

 

As well, changes on image options will only be applied when the Website is refreshed. 

 

Keywords: file transfer protocol 

 

 

Import a WebAcappella (3 and 4) Website folder 

 

A Website folder of WebAcappella (3 and 4) can be imported on WebAcappella 4 very 

easily. 

 

Click on the "Import WebAcappella Website folder" menu and select your Website 

folder. This operation may be carried out from your site under construction or from an 

empty site (in the case of a reformatting / reinstallation of your system). 

 

Note : For a WebAcappella 3 to 4 import, an adaptation work is certainly to be 

expected. Some elements have been redesigned (audio and video elements, buttons, 

photo album, e-commerce), effects have been made unavailable (blur) and other 

effects and features have emerged (Google Web Fonts, text as image...). 

 

 

Keywords: Old WebAcappella, Cariboost, previous version, adaptation, restore, save 



WebAcappella 4 user’s guide – July 2014 

 

Copyright Intuisphere® - All rights Reserved  79 

Dialog windows of the Website 

 

Global user interface color 

Choose here the colors that appear on 

different overlapping windows on your 

Website such as the results of the search 

engine or the blogs.  

 

The preview window allows you to 

apreciate the visual rendering in real time. 

 

 

 

These settings are available from the property inspector of the elements using these 

dialog windows and via the menu "Website" - "Dialog windows settings". 

 

Keywords: Customize contact form, dialog customization, personalization 

 

 

Webspace management 

 

During publication, WebAcappella sends the files from your Website (system files, HTML 

code, images, video,) to your hosting. The Web space manager gives you direct access to 

the files present in this space. Go to “Tools” menu, “Organize your Web space". 
 

By using the Web space manager, you can navigate throughout your Web space to view 

the location of your Websites and possibly delete obsolete files.  

 

You can also erase your site directly from the manager. To do this, simply delete the 

folder containing your site, for example “acappella1” or “acappella4” if you have 

activated the multisite management. If the multisite management is deactivated, simply 

delete all the elements present on your web space.  

 

Do not erase files for which you do not know the origin. In doubt, do not do it.  
 

Keywords: web hosting, site management 
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Colors harmony 

 

 The colors harmony allows you to create a color palette that you will be able to use in 

your elements (for the background, the borders...). These colors will give your website 

an homogeneous look. 
 
1. Colors choice and palette creation 

Click on the "Website" - "Colors harmony" menu. 

You first need to choose the rule for color mix: analogous, monochromatic, triad, 

complementary, compound or shades. 

 

Then, use the cursors to choose your hues. You can parametrize the black settings (and 

the harmony settings for the analogous mode). 

 

You can save various custom palettes. Once you have selected an harmony, you can 

save it by clicking on the "+" button. You can delete it by clicking the "-" button 

 

Once you have chosen your colors, just click on OK to save your palette  

 

2. Use your palette in elements 

Every element using colors in its parameters 

can use the customized color palette. Just click 

on the color picker. 

 

 

 

 

 

 

 

 

 

Then, choose a color or one of its shades to apply it to your element.  

 

You can always create a new harmony or change the hue  

by clicking the button . 

 

  

 
 

 

 

 

 

Keywords: Colors, Theme editor, design, search engine 
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Translation tools 

 

WebAcappella allows you to translate all the application texts and the predefined 

messages of your Website thanks to an integrated application. 

They are available from the "Tools" menu. 

 

This tool allows you to translate the messages available in WebAcappella into a new 

language or to modify an existing translation. The translation of these messages is 

applied as soon as you click the "Save" button. 

 

 

 

Translate WebAcappella interface 

 

 The messages available in this translation interface are the mesages displayed on every 

menus or windows of the application. 
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- Click on the "Tools" menu and on "Localize WebAcappella Interface" 

- In the upper right side of the window, select the source language you want to use 

- In the upper left side, select the language you want to modify or add a new language to 

translate 

- Select a message in the list of messages 

- Make your translations in the white window in the right side 

- The green zone shows you the original message that will help you to make your 

translation 

- Once your translations done, click on "Save" and then on "OK" 

 

Keywords: change language 

Translate the predefined web messages 

 

The predefined messages appear on various parts of your site such as contact form 

(word "Send" on the button). 

 

Note : You can edit these messages either in the default language of your site or if 

you are working on a multilingual site, change the terms of the other languages. 

 
- Click on the "Tools" menu and on "Localize the predefined web messages" 

 

- In the upper right side of the window, select the source language you want to use 

 

- In the upper left side, select the language you want to modify or add a new language to 

translate 

 

- Select a message in the list of messages 

 

- Make your translations in the white window in the right side 

 

- The green zone shows you the original message that will help you to make your 

translation 

 

- Once your translations done, click on "Save" and then on "OK" 
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Modifications are applied automatically to the element 

 

Note : Except for the default language of your website, you need to enable 

multilanguage on WebAcappella (in the "WebSite Properties" and on the page being 

edited) to display and use different languages available for your website 

 

Keywords: Changing predefined messages, web messages 
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E-MARKET 
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E-MARKET 
ONLINE SHOP SETUP 

 

 

The new WebAcappella’s E-market is organized in two main parts: 

One part is called "front office" (your shop in WebAcappella) and the other is called 

"back-office" (the shop's management). 

The  "front office" groups all the components of your shop, including: 

 

- The  "Products" component 

- The  "Cart Button" component 

- The  "Customer Account Button" component 

- The  "Currency Button" component 

 

These components are easily customizable in terms of rendering (especially in terms of 

color). 

 

The "Back-Office" (shop's management) includes all the functions to manage your shop. 

 

Among all the numerous functionnalities and tools, you will find: 

 

Advanced stock 

management 

 

Products, unlimited categories and attributes 

Displaying Multiple images for each product 

Sale of downloadable products (such music, books...) 

 

 

Products Display 

 

Display of available quantities 

Focus on Products 

Add to wish list 

Product Reviews 

Send to a friend 

 

 

SEO optimization 

 

Customizing URL 

Google Site Map 

Meta description for products and categories 

Simplified URL based on the product name 

Title tags by product  

 

 

Orders Order as guest 
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Dispatches 

 

Shipping by price or weight 

Delivery addresses or separate billing 

Unlimited carriers and countries  

 

 

Payments 

 

Different methods of payment and security 

Unlimited Currencies 

Tax automatically configured by country or state 

 

 

Customer Account 

 

Complete Customer Account 

RMA Management 

Centralization of messages in the integrated service 

 

 

Site Management 

 

Administration permissions and user 

Translations of backoffice 

Customize logos on invoices 

 

 

Statistics 

 

Graphical reports 

Visitor tracking 

Customer profiles (top customers, age, orders) 

Catalog statistics 

Order and sales monitoring 

Geolocalization 

 

 

Configuration requirements to install the new e-market version (at the bottom of this 

page): www.webacappella.com/ecommerce.html 

 

Keywords : E-market, shop, on-line shop, buying, products, e-shop, management, 

Prestashop 

 

 

 

E-MARKET SETUP 

Installing your new store: * If you are on a Macintosh System, it is strongly advised to 

install this new e-commerce version in a different folder than "applications" on your 

http://www.webacappella.com/ecommerce.html#anchor-configuration
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computer. In fact, your current version of WebAcappella is installed by default in this 

one. 

 

1 - Open the new version WebAcappella e-commerce 

2 - Create a project (name it) then choose "Empty Website" for example 

3 - Click on "My Shop" button and then "Online Shop setup and management" (a 

warning message appears if your publishing parameters fields are empty) 

4 - In the "General" tab, complete the following fields: 

- Protocol 

- Host (FTP server) 

- Login 

- Password 

- Internet address 

- Remote FTP folder 

 

Then click on the "Test FTP settings" to validate it. If an error occurs, you have to verify 

and perhaps modify these fields. 

 

5 - Go to the "Database" tab: 

- In the field "SQL Driver" choose MySQL 

- SQL database Host  

- SQL database name 

- SQL database Login 

- SQL Password name 

 

6 - Then click on the "Check SQL Database settings" to validate them. If an error 

occured, you have to verify and perhaps modify these fields. 

If all these steps are successful, a new window will appear "Your Shop's parameters": 

 

  

 

 

 

 

 

 

Note: The password must contain at least 8 characters. 

 

 

 

 

 

 

For the type of SQL engine, choose InnoDB engine (more advantageous). The prefix is 

not editable. 
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This option is useful to force the installation of the shop for some hosters (use only in 

case of problems, let untick by default). 

 

 
 

Choose what suits you best. 

 

 

The choice here is free and can be changed later.  

 

Now that all the fields are filled in, your shop can be installed by clicking this button: 

 

 
 

7 - Completion of the installation of your Shop: 

 

Click the "Start Installation" button and wait for a few minutes. For any interruption 

(voluntary or involuntary), each time a message will indicate clearly the way forward. 

 

Once installation is complete, a message will tell you that your shop has been installed 

and configured correctly and a summary screen will be displayed. 

 

Note: That the installation time depends on multiple elements and can take several 

minutes (especially if your account is on a mutualized hosting). 

 

 

Keywords: e-market, shop, on-line shop, e-shop, setup, ftp parameters, database 

name, shop, install 
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INSTALL ADVANCED OPTIONS 

There are 6 topics: 

 

 

If you have not checked the "Insert Image links in the products/combinations CSV 

file" box and now you want to import the pictures of the items from your old shop 

option, then you need to click this button and select the CSV file containing the link (url) 

images. 

 

 

 

 

 

 
 

Keywords: Installation, reinstallation, import, homepage, uninstall, Prestashop 
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THE FRONT-OFFICE WEBACAPPELLA INTERFACE 

Click on this button   to discover the menu of your shop. 

 

 

 

The "Products component"  

 

GENERAL PROPERTIES OF THE PRODUCTS TAB 

 

Products: This will allow you to select and display one or more products from your 

catalog (catalog of products that you have previously created in the back-office section 

of your store: Menu " Catalog " / "Products"). 

Note that during the installation of your new shop, some products are already available. 

 

The "+" button allows you to search the products you want to include in your online 

shop by typing the first characters of the product (search bar) or select them one by one 

or in batches (hold shift and press the left mouse button with the mouse). 

Once selected, press the "+" button. 

 

Categories: The proposed list will be identical to the one you previously created in the 

back office of your shop: Menu "Catalog" / "Categories". 

 

This type of display has the advantage of having a portion of your store products and 

thus identify a category of visitors / customers (e.g. you have created a page titled 

"Computer" and you will want to show only office PC or Macintosh...). 

 

Brands : The brand of a product is its manufacturer. 

Visitors to your site can have quick access to all the products of a given brand. This 

makes navigating your site easier for them. 

 

Layout : A Layout is the way that your products or product categories are displayed. 

This tool may be particularly relevant to the amount of products / categories displayed, 

but also for the aesthetics of the page of your site. 

Indeed, depending on the chosen layout, product display will be different: 
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- Configuration 1: Display as a vertical list containing an image of the product, its 

summary, the price tag... 

- Configuration 2: Same as Configuration 1 except that the display is in the form of Grid 

(View from left to right and not up to down) 

- Configuration 3: Same as Configuration 2 but smaller. Only the product name, image 

and price will be displayed 

- Configuration 4: Big product picture and small list of product characteristics (name, 

price, add to cart and link "see") 

- Configuration 5: Picture is pushed forward and also details 

- Configuration 6: Minimalist. List with a small picture, product name and price. 

 

 

You can select the number of products displayed per page. 

If for example your product list includes 10 products, but you decide to only display 4 

per page then the user must click on the navigation buttons to browse through them all. 

 

 

The shop’s management part 

 

This button is the "core" of your shop 

 

Clicking it will open a new tab directing you to the back-office of your shop. 

 

Refresh 

This tool is for use in the event of changes in product categories (update, delete, add...) 

but also if changes to any property of a product created from the back-office (price, 

pictures, references ...). 

 

CUSTOMIZATION RENDERING COMPONENTS TAB  

 

By clicking on "Edit Properties" from this tab, you can modify and adapt to 

your liking (including colors) the four basic components of your store 

("Products", "Cart Button", "Customer Account Button" and the  "Currency 

Button" components). 

 

These modifications can be done in two ways: 

- By inputting a hexadecimal value 

- By opening a graphics tablet (right button). 

 

For each tab, you can instantly see the changes made and that in the types of layout 

availables in the top right. 
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Product tab:  

 

This tab is the most comprehensive part in terms of possible changes because it is the 

"heart of the display" of your shop. 

Ten properties are customizable, mainly in terms of color: 

 

- The color of the background (for all of the background except for the image of the 

product) 

- The border color (this is the part of the image of the product) 

- The color of the title (change the color of the product name) 

- The color of the description (change the color of the product description) 

- The color of the price (only the color of the product price displayed) 

- The color of the text link "View" 

- You can also replace the text "View" with an icon (preferably an image in jpeg format 

(jpg), png) 

 

Finally, you can also change the icon, the color of the background and the text "Add To 

Cart". 

 

- The icon (preferably an image in jpeg format (.jpg, .png)) 

- The color of the background of this button 

 

Cart tab:  

 

 On the left side is shown an example of a cart that you can see in real time the changes 

you make from the right side, namely: 

     

- The color of the background of the "cart" element 

- The text color 

- Changing the icon cart (preferably a picture in jpeg format (jpg, png)) 

- The color of the separator allows you to change the color of the horizontal bar 

separating the list of products with subtotal cart. 

 

But also you can customize the "Order" button three ways: 

 

- The icon (preferably an image in jpeg or png format) 

- The color of the background of this button 

- The text color of the button. 

 

Account tab:  

 

3 properties are customizable : 
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- The color of the text "Welcome" and "Sign in" 

- The connected icon (preferably an image in jpeg format (jpg, png)) 

- The offline icon (preferably an image in jpeg format (jpg, png)). 

Currency tab:  

 

Three properties are customizable: 

 

- The color background 

- The color font (text) 

- The icon (preferably an image in jpeg format (jpg, png)). 

 

Customization rendering geometric properties tab:  

 

The position and size of the frame component can be modified here (size in pixels). 

 

The "Cart component"  

 
The cart (also called virtual cart or caddy) keeps track of customer purchases throughout his 
course and change the quantity for each reference. 
 

 

• General Properties tab of the cart 

 

• Customization rendering components tab: 

Cf: Component "products" tab customization rendering components 

 

• Customization rendering geometric properties tab: 

The position and size of the frame component can be modified (size in pixels). 

The "Customer Account Button" component  

 

This component makes possible for your customers to have access to their customer 

account: 

 

  History and details of my orders 

  My assets 

 My addresses 

 My personal information 
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 My vouchers 

 My Favorites 

 

 

• General Properties tab of the account 

 

• Tab customization rendering components 

See Component "products" tab customization rendering components 

 

• Tab customization rendering geometric properties: 

The position and size of the frame component can be modified (size in pixels). 

 

The "Currency component"  

 

Your shop may not sell goods or services abroad without the fact that your customers 

have the opportunity to choose between different currencies. 

It is in this component that the list (which you previously defined in the back-office of 

your shop) of the different currencies will appear. 

 

•    General Properties tab "Currency" 

 

•    Tab customization rendering components: 

     See Component "products" 

 

•    Tab customization rendering geometric properties: 

The position and size of the frame component can be modified (size in pixels). 

 
Keywords: shop elements, e-commerce, e-market, international shop, selling to 

other countries, customer space, personalize, shopping trolley, shopping cart, 

basket, exchange 

 

EXPORT / IMPORT TOOL 

This tool allows to export a shop (products characteristics, products name...) created 

under the first release of the WebAcappella e-commerce. 

 

"Tools" menu then "Export WebAcappella products". 

 

Two options for selecting items: either item by item or all items (check the box next to 

"Title"). 
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Once the selection is made, you need to enter a category name to export and click on 

"Export". 

 

Note: that an option on the links images to include or not in the export of items in 

your shop is available: 

 

 
 

Caution: By default, this option is not checked and therefore your items will have no 

images associated. To add some images, go to the install advanced options 

 

This option is particularly useful for servers whose execution time is limited (batch 

processing images in groups of five). 

 

A mini browser will display, asking you where to (which folder) write the export file (csv 

format). 

 

Once the export is completed, you will find at least two files with this name (project-

name_products & project-name _combinations) or more, if ever your site is multilingual. 

 

Now it's time to import your new products in the back-office. 

 To do this, you must click on the button  

 

1.  "Advanced Parameters" menu: 

 

Click on "CSV Import" then on this button  

 

Choose a valid CSV file and click once again on the upload 

button 

 

Caution: If a header is present in the CSV file, you must set 

this value to 1 

 

 
 

2. In the field "What kind of Entity would you like to import?", choose "Products" and 

then select the following check boxes: 
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Then click "Next step" and several times on the right arrow until last column "Price Tax 

Include" and replace "ignore this column" by Price Tax include, then click on the 

button  and wait (this may take some time). 

 

Note: if your prices displayed in your shop include VAT in the amount of the cart, you 

will have to change the last column in your back-office import 

 

You need to perform the same operation if you have other languages on your site 

project but be careful to untick the case "delete all products before import?" ! 

 

 
 

Then, if you have inserted product options, this type of file will also be present: 

"Boutique_combinations". 

So to add combinations of your products, click on  then choose a product 

csv (eg Boutique_combinations) file and click on "upload". 

 

3. In the field "What kind of Entity would you like to import?", choose 

"Combinations" and then select the following check box: 

 

 
 

 Then click on "Next Step" (click "OK" on the next question) and finally click on the 

 button and wait (this may take some time). 

 

So the import of your products is over (ignore the warning or error messages at the end 

of each import products / combinations). You can find them in the "Catalog" / 

"Products" menu. 

 

Note: it is necessary that the current shop (the one whose products will be exported) 

is already online in order to get product images. 

 

 

Keywords: Product, exporting, importing, previous e-commerce, import to new e-

commerce, recover old shop 

 

 

THE BACK-OFFICE MANAGEMENT 

INTERFACE OVERVIEW 
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Take the time to understand the dashboard (e.g. the first page you see when logging 

into the back-office). Not only it gives you a summary of everything you need to know 

about your shop at a glance with links to the most useful pages, but also (as a new user 

to the new e-commerce WebAcappella version) it gives you some tips about settings and 

links. 

 
 

At the top of the back-office is a black bar containing a handful of links: 

 

- (name of your shop). From any page, it takes you back to your Dashboard. 

- Cart icon: opens a tooltip presenting the new orders since you clicked that icon. A red 

tooltip indicates the number of new orders. From there on, you can either display one of 

the new orders, or go to the list of orders. 

- People icon: Opens a tooltip presenting the last registered customers. A red tooltip 

indicates the number of new customers. From there on, you can either display one of 

the new customers, or go to the list of customers. 

- Speech bubbles icon: Opens a tooltip presenting the last customer service message. A 

red tooltip indicates the number of new messages. From there on, you can either 

display one of the new messages, or go to the list of messages. 

- Search field with "Everywhere" dropdown list. Allows you to search within the content 

of your shop – even within your administration page, if you can't remember where an 

option is set. 

- Quick Access: This is the quick links menu, presenting the most useful links, as set in 

the "Quick Access" page under the "Administration" menu. 

- Welcome, (your name) : A simple reminder of which account you are currently logged-

in with. 

- "My Preferences" link: Takes you to your account's preferences page, where you can 

set some personal options (for instance, the back-office language or your password). 

- "Logout" link: Logs you out of the current user account. 

- "View My Shop" link: Opens a new browser tab with your shop's front-end. 

 

The menus 

 

 
 

All along your daily activities administrating your shop, you will have to browse through 

the many pages and options of the back-office. 

 

Each menu proposes a given set of tasks: 

 

- Catalog: This is the heart of your shop, where you will add products, create categories, 

set up carriers and suppliers... 

- Orders: Once clients start adding products in their carts, you will start seeing orders in 

this menu, with the resulting invoices. This is also where you handle merchandise 

returns, credit slips, among other things. 
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- Customers: Here you can access all the information about your clients, and edit their 

addresses, create groups of customers to which you can apply special discounts, handle 

customer service, and even manage social titles if need be. 

- Price rules: A very specific menu, enabling you to easily create vouchers and price 

reductions through a set of rules. 

- Shipping: Everything pertaining to carriers and shipping costs. 

- Localization: Helps you localize your shop with local values, such as language and 

translation, currency, units, taxes and tax rules, and geographical entities (regions, 

countries, etc.) 

- Modules: Extend the power and usefulness of your shop by adding and activating 

modules, a hundred of them being available by default, and many more to buy on the 

Addons marketplace. This is also where you handle themes, and where module’s blocks 

get positioned on the theme. One last menu page enables you to apply global settings to 

payment modules. Ask the technical team before buying modules. 

- Preferences: PrestaShop is a very configurable e-commerce solution, and you can edit 

just about any of its behaviors using the full-featured preferences. 

- Advanced Parameters: Contains links to tools and informational pages that are too 

specific to fit in other menus, such as the web service settings, the database backup tool, 

or the performance page, among others. 

 

 

- Administration: Here are the settings pertaining to the back-office itself, for instance, 

the content of the Quick Access menu, the employees list and permissions, or the menu 

order, among others. 

- Stats: Gives access to all the numerous statistics and graphics that are gathered and 

generated by PrestaShop. 

- Stock (only if the check box to activate the advanced stock management is checked): 

This menu gives you access to a new feature where you can manage your warehouse, 

your movements and your stock replenishment orders. 

 

For any element you want some help, you just have to click on button.  
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